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Introduction

Excel Session 3 is a course created for CAL PACT participants to learn more

about the features of Excel. The course covers simple introductory material

and applies to both the Windows and Macintosh computer platforms. This

document serves as a supplement and future reference to the class.
What you will need to know to take this class

* how to use the mouse

* how to the use the Macintosh or Windows computing environment

* the material covered within the CAL PACT Excel 1 and 2 classes.
Specifically: data entry
editing
formatting
formula entry

printing
What you will learn in this class
* making a chart using the Chart Wizard
* editing a chart

* formatting a chart

Conventions used in this document

Menus and menu commands are separated by a vertical bar (|). In the
document they will appear as Menu | Command. An example of this is
“Select File | New...”
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Making A Chart
Positioning the Chart

There are two options for positioning a chart-on the current worksheet or on
a new worksheet. Charts made on the current worksheet allows the data
and the chart to be viewed at the same time and printed on the same print-
out. Charts made on a new worksheet allows for easier management of the
chart. The chart will appear as a new sheet tab.

If you have lots of data and are only making a chart out of a few data
points, make a chart on a new worksheet so that your worksheet does not
become too cluttered. But if you want your data next to the chart, you might

opt for the chart on the current worksheet.
To create a chart on a New worksheet:

1. Highlight the data to plot. Include cells containing labels for rows and
columns to use in the chart.

2. Choose Insert | Chart | On New Sheet.
3. Continue with the section Chart - Step 1 on the following page.
To create a chart on the Current worksheet:

1. Highlight the data to plot. Include cells containing labels for rows and
columns to use in the chart.

2. Click the Chart Wizard toolbar button or choose Insert | Chart | On This
Sheet.

3. Click and drag the cross-hair pointer to create an appropriate outline for
the chart.

4. Continue with the section Chart - Step 1 on the following page.

If the outline or the location of the chart is not correct it can be modified

with the features outlined later in this document.
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Chart - Step |

Chartwfizard - S5tep 1 of 5

If the selected cellz do not contain the data you wish to
chart, select a new range now.

Include the cells containing row and column labels if you want
thoze labels to appear on the chart.

Bange: =$A.$1 $C312

Step 1 of the Chart Wizard asks to confirm the selected cells in the range
display. If the wrong cells are selected, move the Chart Wizard dialog box

and select the correct cell range or type in the correct range. Click on Next
when the correct range is displayed.

| Help I| Cancel Il < Back l Hext > l Finizh I

Chart - Step 2

Step 2 of the Chart Wizard selects the chart type. Select a chart type and click
on Next or Back if there was a mistake in the previous step.

Chartwizard - Step 2 of 5
Select a chart type:
Area Bar Line Pie
Doughnut Radar XY [Scatter]| Combination | 3-D Area
3-D Bar 3-D Column | 3-D Line 3-D Pie 3-D Surface
| Help | Cancel | < Back l Mext > l Einizh

Know the difference.

What’s the difference between a Line chart and a (XY) Scatter chart?

Many users are unaware of the difference between a line and scatter chart.
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The line chart emphasizes time flow and the rate of change, rather than the
amount of change. The line chart will plot each data point one tick mark
apart regardless of how far apart the x-data is. Only the difference between
one point to the next is shown.

The xy- scatter shows the relationship or degree of relationship between the
numeric values in several chart data series. This means that Excel will
calculates the scale and tick-mark labels for the x-axis, just as it does for the

y-axis. A regression line can be plotted through a xy-scatter graph.

An Example: Looking at a plot of pig numbers vs. how much they weigh.
The numerical value for the pig should not affect how the data is plotted
since all pigs are equal. Looking at a plot of time vs. growth, both time and
growth are dependent and must be plotted according to scale.

Step 3

Step 3 of the Chart Wizard selects the specific format of the chart. Select a
chart format and click on Next or Back if there was a mistake in the previous

steps.
Charfwizard - Step 3 of §
Lelect a format for the Column chart:
1 2 3 4
6 ¥ L] s 10
A |de_
-2
| Help I | Cancel I | ¢ Back I Mext > l Finizh I
Step 4

Step 4 of the Chart Wizard previews how the chart will look. To the right of
the preview, there is a list of three options that can change how the data is
displayed. Choose the proper settings and click on Next or Back if there was
a mistake in the previous steps.

Data Series - Select Rows if the data was entered in rows or select Columns

if the data was entered in columns.
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Use First __ Column(s)/Row(s) for Category (x) axis labels - This option sets
the number of rows/columns to use as the labels for the x-axis.

Use First __ Column(s)/Row(s) for Legend Text - This options sets the

number of rows/columns to use as the labels for the legend text.

Charfwizard - Step 4 of 5
Sample Chart

Data Senes in:
& ) Rows

an i (® iColumns

:::: :- y— Use First |1 E Column[z]
an for Category [X] Axiz Labels.

1500

1::: : Uze First |1_E Bowlz]

1 for Legend Text.

Help Cancel < Back l Mext > l Einizh

Step 5

Step 5 of the Chart Wizard has various option of adding a legend, chart title,
and axis labels. Add the desired labels and click Finish or Back if there was

a mistake in the previous steps.

Charfwizard - Step 5 of 5 Ed
Sample Chart

Add a Legend?
(® Yes
H 1l D ﬂn

o M Chart Title:
LHTE ISampIEI

25 4 Axis Titles
:::: Category [X]: I
1::: Yalue [¥]: I
- v Hurs Han Iy Geplember  Hesrmber Second ¥: I

| Help I| Cancel I| < Back l Mext > I_Einish l

Zample

A chart has now been created! Don’t worry if there is a missing title or axis
label or even if the chart type is wrong, the chart can be edited after it has
been created.
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Working With A Chart
Selecting A Chart

Select a chart by clicking one time on the chart. Selected chart will have
eight tiny boxes around the edge called handles. This only applies to charts
that are created on the same sheet. Charts created on a new sheet will be
selected by default.

Lo = =1

Sample
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1000
0
January Aprl July October
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B Expenze

E

n
=

Opening a Chart

Double clicking on the chart will open it. An opened chart will have the
same eight boxes, but with a thicker border that is highlighted.

Sample

s000
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Resizing the Chart

Resizing a chart applies only when the chart has been created on the same

sheet.

1. Select the chart to resize. The selected chart will now have eight tiny

boxes around the edge called handles.

2. Select the appropriate handle depending on which direction the chart

will be resized. For example, to make the chart wider to the right, select the
handle in the middle on the right edge (and drag further to the right). To

enlarge the chart area down and to the left, select the handle on the lower

left corner.

3. When the mouse pointer is placed over a handle, it turns into a double

arrow. _'

Sample

@ Income

B Ezpense

4. Drag the chart to a new size.

Sample

@ Income

B Ezpense

N i s
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Moving a Chart and its Contents

Moving a chart is similar to moving a cell. Select the chart to move and drag
it to the new location. An open chart can also be moved by dragging the
chart by its border. The Title, Legend, Axis Labels, and other chart objects

can be moved from the opened chart.
1. Select the chart or object within an opened chart to move.

2. The selected chart or object within the chart will show the eight small

control handles around the border.

3. Move the object by dragging the object by its border.

Sample

B Income

B Expense

Editing a Chart

. . zert
The Insert menu allows you to insert or remove Titles Lol Fomat - oo

Titles. ..
(chart title, axis labels, etc), Data Labels, Legend, Axes, ﬁata Labels.
and Gridlines. Legend

byes,
Inserting a Chart Title or Axis Labels Gridlines...

Picture. ..

Open a chart by double clicking on it and select

Insert | Titles....

Legends

To insert a Legend

1. Select the chart and click on the add legend button [BF]. or

2. Open the chart and select Insert | Legend
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To resize the Legend
1. Select the Legend from an open chart

2. Click and drag the legend handles to resize.

New Series or Data

To add a new series or Data to a chart

1. Select and Copy the Data to add from the worksheet.
2. Open the Chart to add the new data or series to.

3. Select Edit|Paste Special...

Paste Special

Add Cells az Yaluez [¥]in—;
@ Mew Series ! Bows
' New Point{s) @® Columns : Cancel

aldil.

[ Series Hames in First Bow
[ Categories [¥ Labels] in First Column
[T Replace Existing Categories

4. Choose to add the new data as a New Series or Row.

5. Choose if the data is in Rows or Columns or if the Series name or Axes
Label are included.

or
1. Choose Insert | New Data....
2. Type the cell range or select the data to add from the worksheet.

3. If Excel cannot automatically determine how to place the new data, the
Paste Special Menu will automatically appear.

Naming a series (i.e. chaning the series name in the legend)
1. Select the series to name.

2. Select Format | Selected Data Series...
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3. Choose the Name and Values tab.

4. Type the series name into the Name box surrounded by quotes.

Deleting
To Delete a Legend, Chart Title, Axis Labels, or Series

1. Select the object to delete (remember selected objects will have handles
on the border).

2. Press the delete key or select Edit | Clear All (for deleting the selected
region) or Edit| Clear Series (for deleting the entire series).

Formatting

The Format menu can customize the chart by changing the chart type, the
font of the chart text, the horizontal and vertical alighment, the text orienta-
tion, the pattern and color of the chart, and the style of the chart text. Re-
member that the chart must be opened before chart object can be selected for
formatting. The first line of the Format menu changes with whatever item
you have selected. Many times, by double clicking on the chart object, the
proper formatting menu will be accessed. To use this shortcut, it is impor-

tant to double click on the correct object.
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Chart Type

The chart type can be changed by clicking on the chart selection button. [yf/+]|
or by opening the chart and selecting Format | Chart Type....

Using the Chart Type menu provides more choices such as chart styles and
Series Order.

Chart Type
-Apply to-——— Chart Dimension
) Selected Series ® 2D 2D
O Group: Cancel

| Area Column

ey

| Line Pie D oughnut

(D

Column Group
tions...

2

Radar
Format Column Group E
] T Series Order T Options T Biris
~Subtype
| OK I
Chart Type... I

o
=0
un
=n
an

15

1m

m
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Plot Area

Chart Area

Format Chart Area E3
Patterns T : £ ]
Font: Font Style: Size:
|Alial |Flegulal |B
Aldus Palette Font | [FFOE [ - | -m
T Algerian 1 |nalic 9
Antigue Olive Bold 10
ol |Bolditalic =i J11 =i
Underline: Color Background:
INnne |;I I Automatic |;I IAutnmalic |;I
Effects——— [Preview
[ Stikethrough
[ Superscript LsBhCoYyIz
[ Subscript
Thiz iz a TrueType font. The zame font will Be used on Both your printer and your screen.

Format Plot Area

~Border -Area
' Automatic ' Automatic

o
=
=]

(8 Custom

Style: Ii :I
Color: [y

Eeight:l EE— :I

HEEOEN
HE EENE |

Sample——

-

attern:

[ox_]
' Hone

Change the background color of the chart or the text on the chart area by
double clicking on the chart area.

The default plot border and area for Excel 5.0 is gray. Change this by double

clicking on the plot area and then changing the color of the area and border
to the desired color.
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Data Series

Select and format the data series to rename the series, change the pattern

(color and markers) of the series, and add error bars or data labels to the

series.

Axis

Format Data Series E2
[ Patterns T Az T W alues
T v Ermar Bars T D ata Labels

Click on the worksheet to select the cells that contain
the zeriez name and the ¥ values.

Mame:  |=Sheet1!$B$1

¥ Values: [=Sheet]1!$B$2:$B413

Sample
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Cancel

dl;

Double click on an axis to change the scale of the plot, the tick marks of the

axis, and the orientation and font of the labels.

Format Axis
Scale T Font T MHumber T Alignment
~Axis ~Tick Mark Type
@® Automatic Major Minor
! Mone
— Cancel
O Custom ' Mone ® Mone
I I Inside C Inside
Style: _— O m
@ Dutside ) Dutside -
Color: I_ :I
) Cross I Cross
Weight:
~Tick-Mark Labels ~Sample
C/ None (O High
) Low (@ Mext to Axis
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Legend

Change the font, placement and pattern of the legend by double clicking on
the legend.

Data Point

To select a certain data point, select the series that contains the data point
and then click on the data point to format. Add labels or change the pattern
of the selected data point.

Format Data Point
Patterns T ]
Data Labels
© None T

(' Show Percent

) Show Label

(O Show Label and Percent

[ Show Legend Key next to Label

Deleting a Chart

If the chart is on a new sheet

1. Click on the sheet tab at the bottom of the screen to select the sheet.
2. Delete the sheet by selecting Edit | Delete Sheet.

If the chart is on the same sheet

1. Select the chart by clicking one time on the chart. The selected chart will
have eight tiny handles around the edge.

2. Clear the chart using Edit | Clear | All or press the Delete key on the
keyboard.
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